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System Requirements

CPU: Intel or compatible x86 family processor
Memory: 512 MB or more RAM (in addition to memory required for the operating system)
Hard drive: 1 GB of available disk space

Operating system: One of the 32-bit or 64-bit Windows operating systems Windows XP Service Pack 3, Windows
Vista, Windows 7, Windows 8, Windows 8.1, Windows 10, Windows Server 2003, Windows Server 2003 R2, Windows
Server 2008, Windows Server 2008 R2, Windows Server 2012, Windows Server 2012 R2

Microsoft NET Framework Version 4.0
Display: 1024 x768 or higher resolution monitor

Label Designer:
« Recommended: NiceLabel Designer Pro or NiceLabel PowerForms V6.0 or higher
o Minimum: NiceLabel Pro V5.4

Recommended printer drivers: NiceLabel printer drivers V5.1 or higher

Fullaccess to the application's 'System folder', where events are logged to the local database:
$Programbata%\EuroPlus\NiceLabel Automation

Fullaccess to the service user account's temporary folder (the location provided by the system variable %temp%)

OPTIONAL -Support for WebDAV: If you will use files from the Document Storage repository available with the
product NiceLabel Control Center. "Installing Support for WebDAV" on page 8.

©

NOTE: The up-to-date system requirements are also available online at
http://www.nicelabel.com/Products/Specifications/System-requirements



http://www.nicelabel.com/Products/Specifications/System-requirements

Checklists

Pre-installation Checklist
CHECKLIST

O Have access to the Windows account with administrative permission

Toinstall NiceLabel Automation software you must have access to the user with administrative privileges.

m} Make sure the Windows account used for Automation Service has its profile created

Log in with the selected Windows account interactively at least once, so its profile willbe created.

O Make sure the Windows account has permissions to use network drives and shared printers

If you will store your label templates on a network drive, or will print to network printers this account must have access to
shared network resources.

m} Disable the password expiration for this account

If the account password expires, Automation service will not be able to run until the password is changed. If your
company’s security policy disallows disabling password expirations, make a note to update the password in Automation
service properties, when the password changes.

Post-installation Checklist
CHECKLIST

O Enable full access permissions to NiceLabel’s System folder
NiceLabel Automation software requires full access (read, write, delete) to its System folder.
$PROGRAMDATA%\EuroPlus\NiceLabel Automation

This is usually not a problem, because folder $PROGRAMDATAS is writable to users by default.

m} Open TCP ports in the firewall for the triggers

If you use Windows Firewall and it is running, the exceptions are added to the list of allowed incoming connections. If
Windows Firewall is off, the exceptions are not added automatically. If you use some other firewall, please configure it
yourself. The exception is configured for Automation service, for all TCP connections on any port.

C:\Program Files (x86)\EuroPlus\NiceLabel Automation\bin.net\NiceLabelAutomationService.exe

[@ NOTE: You have to open ports if you use TCP/IP, HTTP Server or Web Service triggers. ]

m} Open TCP port in the firewall for Automation management (when bundled with NiceLabel Control Center
product)

In order for Control Center to access Automation status and list of triggers, the computer where Automation is installed
has to allow inbound connection to the port 56415 TCP. If both Automation and Control Center run on the same server,
you don't have to open this port in the firewall, connection to the port on the local computer is allowed by default.

@ NOTE: Yo u have to complete this step, if you are using NiceLabel Control Center product and have activated
NiceLabel Automation with a license from the Control Center.

m} Do you use Microsoft Office data files and have 64-bit Windows operating system?

NiceLabel Automation service auto-detects the Windows and will run as 64-bit application on 64-bit Windows, and it will
run as 32-bit application on 32-bit Windows. You will have to install 64-bit drivers for Microsoft Office data files (such as
Access and Excel files) so Automation service can connect to files. For more information see Knowledge Base article
KB262.

@ NOTE: Automation Builder is 32-bit application and will use 32-bit drivers. Testing the trigger in Builder will use
32-bit database drivers. When you deploy trigger, it will use 64-bit drivers.

m} Re-save the label templates (.LBL files) to with at least NiceLabel 5.4.4 (to label version 19)

NiceLabel Automation might not work correctly with the label templates that have been saved with older NiceLabel
designers. The minimum software version is 5.4.4, which saved the labelin version 19.
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Checklists

To verify the label template version, do the following:
1. Openthelabelin NiceLabel Pro.
2. SelectFile>Properties.

3. GotoAdvanced tab.
If you do not see the Advanced tab, click the Advanced button lower in the dialog box.

4. See Label file version field.

Enable encrypted communication for HTTP Server trigger and Web Service trigger (HTTPS )

For more information see the topic Using Secure Transport Layer (HTTPS) in the Automation help or user guide.

Checklist for Communication with Control Center

@ NOTE: Information from this topic only applies if you have also purchased NiceLabel Control Center Pro
or NiceLabel Control Center Enterprise.
CHECKLIST
O Open additional ports in the firewall, when connected with NiceLabel Control Center (optional)
You can bundle NiceLabel Automation with NiceLabel Control Center. In this case you use NiceLabel Control Center as
a licensing server and activate Automation license inside NiceLabel Control Center. Automation can then be managed
from the Control Center.
You have to open the following TCP ports:
Outbound (from Automation towards Control Center)
« 80. Incoming connections to the Control Center. Automation sends updates for the status of the print process
and printer live statuses.
« 8080. Connection to the Document Storage, where label files are stored.
Inbound (from Control Center towards Automation)
« 56415. Incoming connection from Control Center to Automation Service to query it for loaded configurations
and triggers and be able to start/stop them
« 6758. Incoming connection from EPM to LabelServices service to manage printers. You can define firewall
exception for port or for application “Label Services”, C: \Program Files\Common Files\EuroPlus
Shared\LblServices.exe.
O Support for WebDAV to use files in the Document Storage (OPTIONAL: Only if you use NiceLabel
Control Center product)
Each machine that need to access data inside a Document Storage repository, must have the WebDAYV support
installed. Some Windows operating systems have the WebDAV support already installed, for some you have to add the
support before you can access the data.
"Installing Support for WebDAV" on page 8.
O If you use proxy server, exclude local traffic from proxy
Bypass proxy server for local addresses, or Automation might not get the license from the NiceLabel Control Center
and access files in Document Storage. For more information see Knowledge Base article KB163.
O Add Control Center to the Trusted sites

If you have troubles using NiceLabel Control Center, add it to the list of Trusted Sites in your browser.
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Installing Software

Installation Steps
Use the installation wizard to install the labeling software on your PC.
Toinstall the labeling software, do the following:

1. Insertthe product DVD in your DVD drive. An installation window will open automatically.

NOTE: If the installation wizard does not start automatically, double-clickon START.EXE on the DVD.

(.

2. ClickonInstall NiceLabel product. A new window will open, showing all available software editions.

@ Micelabel Automation and Control Iil_lﬂ—hj

Nicelabel £ @ Ingtall NiceLabel product
iceLabe
@  In%tall NiceLabel Printer Drivers

@ Explore DVD

NiceLahel
AUTOMATION & CONTROL

www.nicelabel.com

(%

3. Clickonthe NiceLabel Automation. Follow on-screen prompts.

@ Micelabel Automation and Control Iil_li—hj

Nicelah Ia NicelLabel Control Center
ICeLane
Nicelabel PowerForms Desktop

NicelLabel PowerForms Web

Hi ceLa%gPI Automation
Back

NiceLahel
AUTOMATION & CONTROL

www.nicelabel.com

A

4. Selectthe language you want to use during the installation.

5. You have to accept the License Agreement in order to install the software.



Installing Software

6. Selectthe folder where the application will be installed to. In most cases you will accept the default installation folder.

Nicelabel Automaticn - InstallAware Wizard

&- NiceLabel Automation Setup.

Select Additional Tasks Product install path:
: \Program Files (x85) \EuroPlus\Micelabel Automation

Select the additional tasks you would ke Setup to perform while
installing MiceLabel Automation, then dick Next.

Click Next,
7. Enter the Windows user account the Automation Service will run under.

Make sure to use the user account that will have access to the printer drivers and to the label files, even when available
in the network shared resources.

Nicelabel Automaticn - InstallAware Wizard

E- NiceLabel Automation Setup.

Service Configuration Enter the account under which the services will run.

The Setup will install two service applications: MiceLabel

Automation Service and Nicelabel Automation Proxy Service, [] Use »Local System=account

These services must have privilege to access label files and =
printer drivers in the local or network environment. By default, —
the services will run with the privileges of the currently logged-in DOMAINnicelabel

uger, Enter the password for the logged-in user. To run the
services under different privileges, provide the username and
password of the respective account.

Password:

¢

If you use network-shared resources, make sure to run the g:ea E;I\,Mér;d:ws Services dialog box to change user account setting Q

services under a user account that has the necessary
permissions to access network resources. In this case avoid

using the scal Syztem” account.

WARNING: Avoid using Local System Account for running the Automation Service. This is a limited system
account without access to network shared printers or folders.

8. ClickInstall.

The NiceLabel Automation has been installed in a trial mode. To activate the exact Automation product you have purchased,
see "Activating Software" on page 20

Install Command-line Parameters

NiceLabel installer can be controlled with the command-line parameters.

NOTE: Make sure to use the upper-case syntax exactly as shown. Most of the parameters are used without the
leading slash, there are two exceptions /s (for silent install) and /I (for logging).

There are several command line switches that can be used with the installation program:

Parameter Description
/s Silentinstall. No dialog boxes are displayed. The installer executes in the background.
/I="folder_and_file_name" Logging the installation process in the provided file name. Make sure the user account per-

forming the installation has the access permissions to the folder.

DISABLEANALYTICSSUPPORT | When this parameter is added the, the installer will disable the analytics support. By
default, the user participates in the anonymous analytics reporting.



Installing Software

TARGETDIR="folder_name" Overriding the default installation folder.
ICONDESKTOP Sets whether shortcut icon should be created on the desktop.
ICONQUICKLAUNCH Setitto TRUE to create shortcut icon in the quick launch area. This option is available only
on Windows XP and Windows 2003.
SERVICEUSER Set it to define under which Windows user NiceLabel Automation services should run.
SERVICEPASSWORD Set it do provide the password for the user name defined with SERVICEUSER.
Silent install

NiceLabel Automation installation can be started in silent mode in which the installer will not display any messages during its
progress.

NiceLabelAutomation.exe /s
Setting service user and password

NicelLabelAutomation.exe /s SERVICEUSER=domain\username SERVICEPASSWORD=password

@ NOTE: If SERVICEUSER and SERVICEPASSWORD are not passed to the installation, then NiceLabel Automation
services will run under Local System account.

Setting Destination Path and Disabling Desktop Icon
NiceLabelAutomation.exe /s TARGETDIR= "D:\Apps\Path to Automation" ICONDESKTOP=FALSE
Enabling Quick Launch Shortcut

NiceLabelAutomation.exe /s ICONQUICKLAUNCH=TRUE

[@ NOTE: Allcommand line switches are case sensitive. You have to enter them exactly as shown above (in uppercase). ]

Installing Support for WebDAV

[@ NOTE: Information from this topic only applies if you have also purchased NiceLabel Control Center Pro ]

or NiceLabel Control Center Enterprise.

WebDAV (Web-based Distributed Authoring and Versioning) is a set of extensions to HT TP protocol. It provides a framework
for usersto create, change and move documents on a server; typically a web server or web share.

NiceLabel Control Center provides WebDAV access to the files inside the Document Storage. All clients that interact with the
Document Storage must have enabled the WebDAV support. Usually, the "clients" are NiceLabel PowerForms Desktop and
NiceLabel Automation.

« Older Windows operating systems (such as Windows XP and Windows Server 2003). You must install the
Microsoft Data Access Internet Publishing Provider component. For more information see Knowledge Base article
KB157.

o Current Windows operating systems (such as Windows 7 and Windows 8/8.1). The WebDAYV supportis already
installed.

- Windows Server operating systems (such as Windows Server 2012 R2). You have to enable the Desktop
Experience feature.
Enabling WebClient Service to "Automatic” Startup Type

Windows operating system supports access to WebDAV shares using WebClient service. When this service is stopped users will
not be able to access WebDAV shares. In Windows Server 2003 WebClient service is disabled by default, where as in Windows
XP, Vista, 7 and Windows 8 it is enabled in Manual startup mode. In Windows Server 2008/2012 (including R2) editions, default
setup does not have web client service. You need to install Desktop experience package to add web client service.

To make sure the WebDAV support willalways be available, set the WebClient service startup type to Automatic.
Do the following:

1. Press Windows key (or Ctrl + Esc) to open the search.

2. Typein Services and run the Services window.

3. Scrolldown in the list and locate the service WebClient.
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4. Double click WebClient to open its properties.

5. In Startup type combo box select Automatic.

WebClient

Start the service

Locate WebClient service. oty mer

service is stop)
ill not be avail

If this service is disabled, any ses
that explicitly depend on it will |
start.

Change startup type to
"Automatic”.

Extended

Standard

Py

MName Description Status
1, W3C Logging Service Provides W...
Enables Win...

2% WebClient

General | Log On | Recovery | Dependendies |

Service name: WebClisnt

Display name: WebClient

D ion: Enables Windows-based programs to create,
sscrplon |access‘ and oy Intemet based fils. i this

Path to executable:
C:\Windows \system32'svchost exe + WebClientGroup

Startup typs [Manual

Pase | |

Sati_ || s ||

Resume

from here

You can specify the start parameters that apply when you start the service

Start [

) Services = =] =
File Action View Help
= B H= »eumw

G Senees (Local) | [T G2 ices (Local L ——

Startup Type
Manual
Manual (Trigger Start)

Log OnAs ~
Local Syste...
Local Service
Local Service
Local Syste...
Local Service

ic (Trigger ...  Local Service

[Trigger Start) Local Syste...

[Trigger Start) Local Service

[Trigger Start) Local Syste...
Network 5...

jic Local Service

fic Local Service

lic Local Service
Local Service
Local Syste...

ic Local Syste...
Local Syste...
Local Service
Local Syste...

jic Network 5...

[Trigger Start) Local Syste...

[Trigger Start) Local Service

I

Apply

6. Ifthe service is not running yet, click Start button.

7. Click OK.

8. Close Services window.

Installing Desktop Experience

To install Desktop Experience on Windows Server operating system, do the following.

Installing Software

@ NOTE: These instructions are for Windows Server 2012 R2.

1. Start Server Manager from the Start screen.

2. ClickManage, then click Add Roles and Features.
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2 Server Manager = | = -

Manage  Tools Vi

H
x
T
5

Server Manager * Dashboard -@ 1 r

Add Roles and Features
Remove Roles and Features
\rNELCOME TO SERVER MANAGER PO
i Local Server Creste Server Group
Hi Al Servers Click Add Roles and Features. T s
ii File and Storage Services P

QUICK START
Add roles and features

[\S)

(o]

Add cther servers to manage

WHAT'S NEW
4 Create a server group
Hide
LEARN MORE
ROLES AND SERVER GROUPS
Roles: 1 | Servergroups:1 | Servers total: 1
=m File and Storage
Ly g 1
Services
@ Manageability @ Manageability
Events Events
Performance Services
BPA results Performance
RPA racylt -

Select Role-based or feature-based installation. Click Next.

= Add Roles and Features Wizard \;‘i‘

DESTINATION SERVER

Select installation type Cleanssvzoi2a2

Select the installation type. You can install roles and features on a running physical computer or virtual
machine, or on an offline virtual hard disk (VHD).

Befors You Begin

Installation Type

@ Role-based or feature-based installation

Server selection X X X
Configure a single server by adding roles, role services, and features.

) Remote Desktop Services installation
Install required role services for Virtual Desktop Infrastructure (VDI) to create a virtual machine-based
or session-based desktop deployment.

Select a local server from the server pool. Click Next.

The Desktop Experience feature is not a Server Role, so skip the Server Roles page by clicking Next.

Inthe Select Features section, expand User Interfaces and Infrastructure and check the Desktop Experience
check box. Probably it willnow ask you whether you also want to install the features required by Desktop Experience.
Clickthe Add Features button to proceed. Now, click the Next button to proceed.

10
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Se ‘ ect featu res CIeanSRVEDIZRzE?L;‘XM\::E?D:Iiﬁ:iRI

Before You Begin Select one or more features to install on the selected server,

Installation Type Features Description
Server Selection . A Desktop Experience includes
Server Bolas [] Simple TCP/IP Services ] features of Windows 8, such as
- SME 1.0/CIFS File Sharing Support (Installed) Windows Media Player, desktop
Fea [] SMB Bandwidth Limit themes, and photo management.
Confirmation ] SMTP Server Desktop Experience does not enable

any of the Windows & features; you

b [ SNMP Service must manually enable them.

[ Telnet Client
[] Telnet Server
[C] TFTP Client 1
4 [W] User Interfaces and Infrastructure (2 of 3 installed)

raphical Management Tools and Infrastructu,

skto riencey
Server Graphical Shell (Installed)
[ Windows Biometric Framewark
] Windows Feedback Forwarder

— - - ~

<[ 1] | [>] |

7
:
=
:

install | [ cCancel |

In the Confirmation section, optionally check the Restart the destination server automatically if required check
box as the Desktop Experience feature will need a restart to complete. You can also manually restart the server after
the wizard completed.

DESTINATION SERVER

Confirm installation selections CleanS4201282 GALAXY curoplus ol

Before ‘You Begin To install the following roles, role services, or features on selected server, click Install.

Installation Type [] Restart the destination server automatically if required

Server Selection Optional features (such as administration tools) might be displayed on this page because they have
been selected automatically. If you do not want to install these optional features, click Previous to clear

Server Roles their check boxes.

Features

Ink and Handwriting Services
Media Foundation

User Interfaces and Infrastructure
Desktop Experience

Export configuration settings
Specify an alternate source path

[<Previous | | Next> | [ nstall |[ Cancel |

Wait while the features are being installed. You can also close the Add Roles and Features Wizard window if you
want; it will continue in the background.
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Installing Printer Drivers

You can use the labeling software to design and print labels to standard office printers, such as laser, ink jet or dot matrix, to
professional output devices, such as thermal label printers or other marking devices (inscribing laser, high-speed ink jet). For
any printer you have, you first have to install the appropriate printer driver before you can use it. NiceLabel software is
accompanied with the printer drivers all major thermal printer brands.

Printer Driver Installation Using the Printer Installation Wizard
1. Putthe NiceLabel DVD in your DVD-ROM drive. The main installation application will start automatically.

NOTE: If the installation wizard does not start automatically, double-clickon START.EXE on the DVD.

(.

2. ClickonInstall NiceLabel Printer Drivers. The printer installation wizard will start. Follow on-screen instructions.

@ Nicelabel Automation and Control l = S
Nicelabel £ @  Install NiceLabel product
ICeLane
e Install NiceLabel Printer Drivers

I
(] Expﬂ?e DVD

NicelLabel
ALUTOMATION & CONTROL

www.nicelabel.com

(S

3. Select your printer from the list. Click the Next button.
4. Selectthe portwhere you have connected your printer.

5. Ifthe printer requires a dedicated bidirectional port monitor, click the Port button and follow on-screen instructions.

NOTE: Using the NiceLabel-provided port monitor (Advanced Port Monitor) is mandatory for network-
connected label printers, if you want to enable bidirectional communication with the printer (for printer and
print job statuses).

12



Installing Printer Drivers

i '1

Optians

Printer Options
Please zelect part, printer name and language.

Enter the name for pour printer. Alzo, select the port your printer iz connected to, Wwhen you are
done, zelect <Finish> to inztall the printer and add an icon ta the Printers folder.

Diniver werzion: £ 0085335
Printer name: w0 0 i

Ayailable ports:

COME: -
COME:

COMT: —
Dezktoph” pdf (4 [
Diocuments'?. pdf

FILE:

LAM_10.41.2199 -

[T] 1 weant to uze this printer as the Windows default printer.

[elete Paort...

Exit ] [ Help ] [ < Previous ] ’ Einizh

e

6. Clickthe Finish button.

e NOTE: If you have downloaded the installation for NiceLabel printer drivers from the product web site, run the
downloaded executable file and follow on-screen instructions.

Printer Driver Installation Using the Windows Add Printer Wizard
1. InControl Panel, select View devices and printers to open Devices and printers.

2. Click Add a printer.

@Qv|@ » Control Panel » Hardware and Sound » Devices and Printers

Add a device Add a prigter

4 Devices (11)

Start the Add Printer Wizard, which
helps you install a printer

3. Follow the Add Printer Wizard prompts. The actual steps vary depending on the version of your Windows operating
system.

4. |Ifyou areinstalling printer driver from some print server all necessary files will be available on that server.

5. [Ifyou areinstalling printer driver for local or network stand-alone printer, you will have to select the printer driver
yourself.

Do the following:



Installing Printer Drivers

1. Clickon Have disk button in the step where you can select printer manufacturer and model.
2. Putthe NiceLabel DVD in your DVD-ROM drive and browse to the folder Drivers.

3. Selectthe folder of your printer name. You will see the list of all available printer models of the selected
manufacturer.

4. Select your model, click Next and finish the installation.

6, NOTE: If you have downloaded the NiceLabel printer drivers from the Web site and extracted them to disk,
you can browse for the files in c:\NiceLabel Printer Drivers.

gontroi!ling the Printer Installation Wizard (PRNINST.EXE) in the Command
romp

You can automate the NiceLabel printer driver installation process hiding all dialog boxed. You can control the installer with the
command-line options.

For more information see Knowledge Base article KB253.

14
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Installation into Cluster Environment

Failover (High-availability) Cluster

Afailover cluster is a group of independent computers that work together to increase the availability and scalability of clustered
roles (formerly called clustered applications and services). The clustered servers (called nodes) are connected by physical
cables and by software. If one or more of the cluster nodes fail, other nodes begin to provide service (a process known as
failover). In addition, the clustered roles are proactively monitored to verify that they are working properly. If they are not
working, they are restarted or moved to another node. With the Failover Clustering feature, users experience a minimum of

disruptions in service.

Virtual Address

-+ ——mmm e m i — - -
Heartbeat

Shared Storage

The Enterprise edition of NiceLabel Automation supports failover (or high-availability) clusters.
To set up NiceLabel Automation in such environment, do the following:
1. Installand activate NiceLabel Automation on each clustered server (node).
2. Setup Failover Clustering feature in Windows Server. Note that clustering is not available in all editions of Windows

Server.

Enable failover cluster support in NiceLabel Automation Configuration and define a folder where files, needed by
NiceLabel Automation to support failover cluster, are copied to. This folder should be on a server that all cluster nodes
can access and NiceLabel Automation has full access to it. You can find the settings under the Cluster Support

category.

[@ NOTE: The list of currently loaded configurations and trigger states (enabled/disabled) will be stored in this ]

w

folder.




Installation into Cluster Environment

F R
Options ﬂ

General Settings
Falders
Language
Label usage passwords ¥ Enable Failover Cluster Support [A service restart is required)

User rights and access
Cluster sh th:
Control Center b

Manitor events I\\SharedSer\fef\Storage Browse.., |

Maonitor print jobs
Settings

Micelabel Automation
Settings
Production settings
Cluster Support

oK Cancel Apply Help

4. SetNicelLabel Automation Proxy Service and NiceLabel Automation Service startup type to manual.

[ - .
. Services | == = |

File Action View Help

e Bl HeEl > w
o, Services (Locg . Senvices (Local)
Nicelabel Automation Service Name ° Description Status Startup Type g~
£ Network Store Interface Service This service ...  Started Automatic
%ﬁ;z::i‘;ﬁie (% Nicelabel Automation Proxy Service  Serviceforc...  Started Manual
Restart the service L NiceLabel Automation Service Service for...  Started Manual
£ NVIDIA Display Dri i ic
- " [
Descript £ O2FLASH Nicelabel Automation Service Properties (Local Computer) ﬂ
escription: .y |
Service for middleware integrated o OZSDI0As=3
printing. £ Office Sourg | | Genersl | Log On | Recovery | Dependenual
£ Office 64 Sol

2% Office Softw Service name Nicelabel AutomationService]

’,JJ Offline Files Display name: Nicelabel Automation Service

J"‘J Parental Co Description: ervice for middleware integrated printing. s

£+ PDF Archited e |
L pdfforge Crd) |

JHJ Peer Name Rl Path to executable:

Py C:A\Program Files {86)\EuraPlus‘\Nicelabel Automationbin net'MNicelabel A

i Peer Metworl)|

G Peer Networl | Startup type: [Manual v]

~ Performanci

Help me corfigure service startup options.

L Performancy
54 Plug and PIq.

- S status:  Started
CiPrl Driver fff| | TRV RAMSE e |
(% PrP-XIP Bul Start Stop Resume
! —
4 m b Extended A Standard / ;::run f]a;espeefythe start parameters that apply when you start the service
= | Start p e

5. Setthe start parameter for NiceLabel Automation Service to configuration file that will be run when the service starts.
Configuration files should be stored in a location that is accessible by all nodes.
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-
Micelabel Automaticn Service Properties (Local Computer)

==

General | Log On | Recovery I Dependenci&s|

Service name: Mice Label Automation Service

Display name: Micelabel Automation Service

Description: |Sem'ce for middleware integrated prirting.

Path to executable:

C\Program Files (c88)"FuroPlus\Nicelabel Automationbin net'\NicelabelA

Startup type: [ Manual

-

Help me configure service startup options.

Service status:  Stopped

Start Stop Pause Resume
You can specify the start parameters that apply when you start the service
from here.
Start parameters: ““Shared ServerStorage Yconfiguration misx

/
ok | Cancel

Installation into Cluster Environment

6. Configure the cluster to start NiceLabel Automation on the backup node, when the main server becomes

unresponsive.

Load-balancing Cluster

Load balancing is a computer networking method to distribute workload across multiple computers or a computer cluster,
network links, central processing units, disk drives, or other resources, to achieve optimal resource utilization, maximize
throughput, minimize response time, and avoid overload. Using multiple components with load balancing, instead of a single

component, may increase reliability through redundancy.

Client Client

L

l |

Load Balancer

Server1 Server? @ =— — — — — =

Network Load Balancing clusters provide scalability and high availability for TCP-based services and applications by combining
several serversinto a single cluster. By using Network Load Balancing feature of Windows Server to build a group of cloned, or

identical, clustered computers, you can enhance the availability of these servers.

When the load balancer receives a request from the client, one of the serversin the group processes the request. Every server
is capable of handling the request independently. If any server is unavailable due to error or maintenance, other servers can still

serve requests without being affected.

In NiceLabel Automation, all TCP-based triggers can take advantage of the load balancing. This includes TCP/IP Server

Trigger, HTTP Server Trigger and Web Service Trigger.



Installation into Cluster Environment

There are no special settings in NiceLabel Automation to support load-balanced cluster. When you have allthe hardware and
cluster configuration in place, you need to install NiceLabel Automation on all servers in the cluster and then load the same
configuration file in all instances.
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Installing Upgrades

In the software upgrade you upgrade an older version with the newer version. During the upgrade the program components
are upgraded, but all user data files and activation information remain intact.

Do the following:
1. Onthe computer with NiceLabel Automation installed, close Automation Builder and Automation Manager. If you
have any other NiceLabel software running, such as NiceLabel designer, close it as well.

2. Startthe installation of the new version.

The installer of a new version will detect the old version. It willremove it (keeping all necessary data) and installa new
version in the same folder, replacing the old one.

Nicelabel Automaticn - InstallAware Wizard

ﬁNiceLabeI Automation Prerequisite

NiceLabel Automation Setup needs to update your
system.

Setup must install newer versions of the following system
components before installing MiceLabel Automation.

(i) Toinstal the program, setup must perform following
actions:

Previous Yersion Uninstallation = 4[
NicelLabel Automation

4. Follow the prompts.

5. The new version will re-use the license from the old version.

[ NOTE: During the upgrade the log database will be emptied. ]




Activating Software

You must activate NiceLabel Automation software to enable processing of the configured triggers. The activation procedure
requires the Internet connection, preferably on the machine where your are installing the software. The same activation
procedure is used to activate the trial license key.

You can activate the software either from Automation Builder or Automation Manager and achieve the same effect.

Activating a Stand-alone License

In this case you have NiceLabel Automation Enterprise, NiceLabel Automation Pro or NiceLabel Automation Easy
license that you want to activate directly in the NiceLabel Automation software.

To activate the NiceLabel Automation software, do the following:
1. Run Automation Builder.
Select File>Tools>Manage License.
or
Run Automation Manager.
Goto About tab.
Click Enter License Key.

2. InManage license dialog box, select Single user Software Key.

r ™y
Manage license M

Welcome to Product Activation Wizard
This wizard will guide you through the product activation process.

Product has not yet been activated or no valid licenses could be found. Please follow this
Activation Wizard to activate your copy of product or troubleshoot your active license,

Flease choose product activation method:

(@) Single User Software Key

() Multi-user Software Key

(") Contral Center license server

b

Click Next.

3. InManage license dialog box, enter the user information and the Key number.
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4.

r Y
Manage license g
User Information
Enter user information.
Please enter your information. Note that fields marked with * are required.
MName Micelabel Automation User =
Company Company *
Address Line 1
Address Line 2
Zip or Postal Code City
Country USA *|*®
E-mail user@company.com ®
Key Mumber - - - = *
Cancel ] ’ <« Back ] [ Hext = ] Einish
b
Click Next.

Activating Software

If this computer has the access to the internet, click the Automatic Activation link. The software willbe activated

automatically.

(.

F' R
Manage license u
Activation Code
Enter activation code,
Flease enter software activation code.You can save activation data into file by pressing button
save.
Key Mumber
- g . — - If your computer is connected
e =) =
. "l —— —— to the internet, you can select
Registration Mumber the automatic activation link.
L = CLEe N S L i e
Activation Code
] Activation Code can also be
acquired through the
publisher's Activation Web
page.
Automatic activation K
Web page activation
’ Save data ] [ Cancel ] ’ < Back ] [ Mext = ] Finish
b
-
6, NOTE: If this computer does not have access to the Internet, "Activation without Internet Access" on page 28. ]

21



Activating Software

Activating a License in Control Center

6 NOTE: Information from this topic only applies if you have also purchased NiceLabel Control Center Pro
or NiceLabel Control Center Enterprise.

In this case you have NiceLabel Automation Enterprise or NiceLabel Automation Pro license that you will activate in the
Control Center. When linking your NiceLabel Automation product to the Control Center you receive many benefits, including
access to the centralized repository of labeling files in the Document Storage, access of consolidate history of all printing events
and management of remote printer queues.

[e NOTE: Prior purchase of NiceLabel Control Center Enterprise or NiceLabel Control Center Pro productis
necessary.

[e, NOTE: You cannot activate NiceLabel Automation Easy license in the Control Center. ]

To activate the NiceLabel Automation license in the NiceLabel Control Center, see the NiceLabel Control Center
Installation Guide. ###

To activate the NiceLabel Automation software with a license from NiceLabel Control Center, do the following:

NOTE: Make sure the NiceLabel Automation license is already activated in the Control Center, before attempting to
complete these steps.

1. Run Automation Builder.
Select File>Tools>Manage License.
or
Run Automation Manager.
Go to About tab.
Click Enter License Key.

2. InManage license dialog box, select Control Center license server.

F ™
Manage license u

Welcome to Product Actlivation Wizard
This wizard will guide you through the product activation process,

Product has not yet been activated or no valid licenses could be found. Please follow this
Activation Wizard to activate your copy of product or troubleshoot your active license.

Flease choose product activation method:
() Single User Software Key

() Multi-user Software Key

@ Cot\:ol Center license server

e

Click Next.

3. InManage license dialog box, type in the Control Center server name, or click the browse button to find the server in the
network.
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Activating Software

F' R
Manage license ﬁ

Control Center license server
Select Control Center server name,

Please enter the name of the server where Control Center is installed.

Control Center server name

SEMver G

|:|55L connection

Caneel ] ’ < Back “ Next > Finish

P
6 NOTE: If Control Center has been configured to work using the encrypted HT TPS connection, enable the
SSL connection option.

-

Click Next.

4. |Ifthereisafree license available in the licensing server, NiceLabel Automation will be activated.

The Automation will be configured to send all details about print events into the Control Center database.

F N
Control Center license server u

WARMING: Changes in program configuration

??ﬁ Activation Wizard has successfully connected to the
license server. This results in following program
configuration changes:

Print job information will be logged on the server
Printing events will be logged on the server
Detailed printing control will be enabled

You can use the Options menu or the produc configuration tool
to change these settings.

P
6 NOTE: These settings can be configured in the NiceLabel Automation Configuration. ]

.

5. InManage license dialog box ,the information about the obtained license is displayed.
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Activating Software

-

-
Manage license ﬁ

License information
Control Center license server information

Caontrol Center license server information:

Mame Value
Product: Micelabel Automation
License Level: Automation Enterprise
License Type: Micelabel Cantral Center license
Key Number: g T, BT LS S L
Wersion: 1x
Open License Manager Open License Information

If you would like to see or manage current license or add new license, the wizard will assist
you with the license manage process.

6. ClickFinish.

Activating a Desktop Suite license

In this case you have NiceLabel Desktop Suite or NiceLabel Desktop Suite Multi-user product thatincludes NiceLabel
Automation Easy.

For detailed activation steps see the NiceLabel Designers Installation Guide.
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Activating Upgrades

Activating Stand-alone Upgrades
Upgrades allow you to move your current NiceLabel Automation product level to the next more powerful edition.

For example, you would update NiceLabel Automation Pro to NiceLabel Automation Enterprise to benefit from the new
functionality available only in the Enterprise product.

To upgrade to the more powerful edition of NiceLabel Automation, you do not have to upgrade the software, you just need to
upgrade the license key.

To upgrade a stand-alone license, do the following:
To deactivate the stand-alone license, do the following:
1. Start Automation Builder.
Select File>Tools>Manage License.
or
Start Automation Manager.
Goto About tab.
Click Manage license...

2. Selectthe option Manage current software key license .
F' R
Manage license u

License information

Software key license information:

Mame Value

Product: Micelabel Automation

License Level: Automation Enterprise

License Type: Software Key

Key Mumber: oHEA TS BT AN WD wTEY
Wersion: 1x

If you would like to manage the current software key license, the wizard will assist you with
the license management process.

Manage current software key license

e

3. Click Next.

4. Selectthe option Upgrade software key license and follow on-screen instructions.
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Activating Upgrades

F' R
Manage license ﬁ

Manage software key license

Please select your action.

@ Upgrade software key license
This will start software key license upgrade process, User must have a valid upgrade
key number to successfully finish the upgrade process.

(") Deactivate license
If you want to use your software key license on another workstation, you have to
deactivate it first. Important: You need internet connection to proceed.

Cancel ] ’ = Back H Mext = Finish

e

P
e NOTE: Make sure the computer can access the Internet. The license willbe returned to the internet activation

server.
.

5. Enterthe Upgrade Key Number.

6. Ifthiscomputer has access to the internet, click the Automatic activation link. The upgrade will be activated
automatically.

r ™y
Manage license ﬁ

Upgrade code
Enter upgrade code.

Flease enter upgrade key number and upgrade activation code. You can save activation data
into file by pressing button save.

Old Key Number
If your computer is connected
to the internet, you can select
Upgrade Key Number the automatic activation link.

oot TR BT AN WSS TR

Registration Mumber
Activation Code can also be
AQHAR  SHUMO  RXYBE GF7RT WHNVEG acquired through the

Activation Code publisher's Activation Web
page.

Automnatic activation

Web page activation

’ Sawe data ] [ Cancel ] ’ < Back H Mext = J Finish

b

p
e NOTE: If this computer does not have access to the Internet, "Activation without Internet Access" on page 28. ]

|\
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Activating Upgrades

Activating Control Center Upgrades

6 NOTE: Information from this topic only applies if you have also purchased NiceLabel Control Center Pro
or NiceLabel Control Center Enterprise.

To upgrade the NiceLabel Automation license activated in the Control Center, see the Control Center Installation Guide.
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Activation without Internet Access

The automatically activate NiceLabel Automation you must have the connection to the Internet during the activation procedure.
You can install NiceLabel Automation on the server without the Internet connection, but you will still need to have the Internet
connection on some other machine, where the activation procedure will be completed.

Do the following:
1. Follow the normal activation procedure for either Stand-alone or Control Center license.
Enter the license key, the registration number willbe generated.

2. InManage License dialog box, click the button Save data.

F ™
Manage license u

Activation Code
Enter activation code,

Flease enter software activation code.You can save activation data into file by pressing button

save.

Key Mumber

iy — .. it Smame If your computer is connected
to the internet, you can select

Registration Mumber the automatic activation link.

afm g T, LN i

Activation Code
] Activation Code can also be
acquired through the

publisher's Activation Web

page.
Automatic activation
Web page activation
Save data ] [ Cancel ] ’ < Back ][ Mext = ] Finish

3. Selectthe folder, where you want to save the activation details, such as Key Number, Registration Number, and URL of
the web page activation .

The suggested folder is NiceLabel Automation System folder, but you can select any other folder.
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-

Select the folder where you want to save the software a..

Select the folder where you want to save the software
activation information, if you computer does not have
internet access. The file ACTIVATION. TXT will contain the
entered user information along with key and reqistration
numbers. You can use the information for software
activation on some other computer with internet access.

b . Nicelabel 5 2
2 | MiceLabel &
w* || Nicelabel Automation
N Jsysten]| 3
[ | system.net
3 | MiceLabel Designer Express 6
3 | MiceLabel Designer S5E &
3 , MicelLabel Designer Standard &
Mew Folder ] ’ QK ] ’ Cancel
e
Click OK.

The file with activation details ACTIVATION.TXT will be saved to disk.

Activation without Internet Access

-
Infarmatian

'

Click OK.

Go to the computer that has access to the internet. Open the file ACTIVATION.TXT in text editor, such as Notepad.

Make sure the pop-up blocker has been temporarily disbaled.

Open the activation URL from the saved file.

The Web activation page willopen.
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Activation without Internet Access

Automation Activation

Welcome to the NiceLabel Automation activation site. Please copy the data from your
NiceLabel Automation activation dialog box into the fields below. Then press the ACTIVATE
button.

Key Number: £200% we oL Boomgd AL il

Registration Number: | et TG RO Boomngl KpELH

Name: |NiceLabeI Automation User

Company: |C0mpany

Address 1:|

Zip: | | city: |
Country: | United States v

|
|
|
Address 2:| |
|
|
|

E-mail: |user@company.com

* - required

| ACTIVATE | [ RESET

8. Enter the values for allrequired fields.
9. Click ACTIVATE button.

10. The Activation Code will display on-screen. Remember it.

[@ NOTE: The Activation Code is also sent to the provided email address.

11.  Go back to the computer, where you started to activate the software.
In the Manage License dialog box, enter the Activation Code into the software.

12. Click Next button.

[@ NOTE: If you do not have access to the Internet at all, please call the Technical Support for phone activation.
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Deactivating Software

When you use NiceLabel software activated with the software license key, you can deactivate the software and easily move the
license to other workstation.

@ NOTE: The primary use of deactivation is move of the software to some other workstation. If you want to reinstall it, or
make the upgrade on the same workstation, you do not have to perform the deactivation.

Deactivating Stand-alone License
To deactivate the stand-alone license, do the following:
1. Start Automation Builder.

Select File>Tools>Manage License.

or

Start Automation Manager.

Goto About tab.

Click Manage license...

2. Selectthe option Manage current software key license.

P ™
Manage license ﬂ

License information

Software key license information:

Mame Value

Product: Micelabel Automation

License Level: Automation Enterprise

License Type: Software Key

Key Number: iiim e CETTLT AN WED e
Wersiomn: 1.x

If you would like to manage the current software key license, the wizard will assist you with
the license management process.

Manage current software key license

3. Click Next.

4. Selectthe option Deactivate Software and follow on-screen instructions.
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Deactivating Software

-

-
Manage license ﬁ

Manage software key license

Please select your action.

(") Upgrade software key license

This will start software key license upgrade process, User must have a valid upgrade
key number to successfully finish the upgrade process.

@ Deactivate license

If you want to use your software key license on another workstation, you have to
deactivate it first. Important: You need internet connection to proceed.

Cancel ] ’ = Back ][ Mext = J Finish

P
e NOTE: Make sure the computer can access the Internet. The license willbe returned to the internet activation ]
server.

|

Another possibility of software deactivation is to uninstall the software. During the removal process you will be prompted
whether you also want to remove the license. If you plan to install the software again on this machine, you can keep the license

installed to save you some time for activation the next time. If you will move the software to another machine, then deactivate the
license.

Deactivating License from Control Center

e NOTE: Information from this topic only applies if you have also purchased NiceLabel Control Center Pro
or NiceLabel Control Center Enterprise.

If you want to deactivate NiceLabel Automation license activated in the Control Center, please follow license deactivation
procedure in the Control Center Installation Guide.
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Support

Online Self-help

You can find the latest builds, updates, workarounds for problems and Frequently Asked Questions (FAQ) on the product web
site at www.nicelabel.com.

For more information please refer to:

« Knowledge base: http://kb.nicelabel.com

« NiceLabel Support: http://www.nicelabel.com/support

« NicelLabel Tutorials: www.nicelabel.com/Learning-center/T utorials

« NicelLabel Forums: forums.nicelabel.com

Troubleshooting

(| Software does not install

When the installer does not complete successfully despite following all rules for the prerequisites, enable the install log
file and send it to the regional Technical Support team.

To create the install log, do the following:
1. PressWindowskey + R and type in cmd.
2. InCommand Prompt window, go to current user's temporary folder. Type in:
cd Stemp$
3. InCommand Prompt window, create an empty textfile 1lblinstall.log. Typein:
type nul > lblinstall.log
4. Runthe NiceLabel Automation installagain. When the error displays again, close the installer.
5. Contactthe regional Technical Supportteam and provide the 1blinstall. logfile.
O Automatically notify NiceLabel Automation Service of newly installed network printer driver

When the new local printer driver is installed in Windows system, NiceLabel Automation Service will be notified about it.
The NiceLabel Automation Service can start using the printer driver immediately without the need for the Service
restart. The NiceLabel Automation Service only needs permissions to access the printer driver. However, depending
on your system, you might need to enable the inbound rule for NiceLabel Automation to be notified about the new
printer.

For more information see Knowledge Base article KB265.

O NiceLabel Automation Service 1.0.5 doesn't start on Windows 8 and Windows Server 2012

You have successfully installed NiceLabel Automation on your Windows 8 or Windows Server 2012 machine, but the
services NiceLabel Automation Service and NiceLabel Automation Proxy Service failed to start. If you manually try to
start the service in the Services console, you might receive the error message "Error 1053: The service did not respond
to the start or control request in a timely fashion".

For more information see Knowledge Base article KB258.

O NiceLabel Automation Manager shows the error 'The Microsoft.Jet.OLEDB.4.0 provider is not registered
on the local machine'

The error message will display when you use any of the following in your NiceLabel Automation configuration to connect
to the Microsoft Access database: database trigger, action Execute SQL Statement, database connection on the label.
The Microsoft.Jet. OLEDB.4.0 provider is NOT AVAILABLE as 64-bit component, it was only developed as 32-bit
component. You will have to use a different driver to use data from your database.

For more information see Knowledge Base article KB262.

O NiceLabel Automation products are not 100% compatible with NiceWatch (Enterprise) V5 and label
designers V6

For example, there are some label design features that you can use inside label designer, but you cannot use in
Automation (in the current version). When you try to print label with incompatible features, NiceLabel Automation will
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display a warning and details about the problem. You will have to remove the unsupported functionality from the label
template. Newer versions of NiceLabel Automation will gradually add the functionality to match the label designer.

For more information see Knowledge Base article KB251.

Set Printer action fails when connected to the server using Remote Desktop Connection

By default, when you make a Remote Desktop Connection to the remote computer the application will make local client
printer drivers available in the remote session. If you try to use such forwarded printer for printing, Automation will fail
with the error message "MergeDevMode for <printername> failed".

To prevent this error from happening, do any of the following:
« Disable forwarding of local printer drivers in the Remote Desktop Connection application.
« Make sure the printer driver required by the label is installed on the target computer.
« Use the Set Printer action in front of the Print Label action to ensure usage of the correct printer.

For more information see Knowledge Base article KB264.

NicelLabel Automation Builder and NiceLabel Automation Service run under different user names, which
can make the testing difficult

NiceLabel Automation Service runs with credentials of the user name specified for the service. Automation Builder runs
with credentials of the currently logged-in user. This makes testing difficult as different users might have different
permissions on the system.

@ NOTE: The NiceLabel Automation Builder is capable of accessing the network shared files while you are
building a configuration, while the NiceLabel Automation Service might not be, because it runs under user
account with different security permissions.

You could temporarily run the NiceLabel Automation Builder under the same account as Service using Windows
command-line utility runas.

For more information see NiceLabel Automation help topic Using The Same User Account To Configure And To
Run Triggers.

Inbound connection to NiceLabel Automation Service is allowed in the firewall, but the TCP trigger data
does not come through

The NiceLabel Automation service doesn't open the TCP socket with the processid (PID) under which the service runs,
but with the PID 4, which belongs to SYSTEM process. When you want to allow inbound connection to the defined TCP
socket, the firewall rules defined for NiceLabel Automation Service have no influence as the port was opened by
another process (SYSTEM vs NiceLabel Automation Service). The connection to the portis denied because TCP
socket is not governed by Automation Service, but by SYSTEM process. You can use the command-line utility
NETSTAT to find out which application / process is bound to a particular port.

Use the following syntax:
netstat.exe —-ano

In this case, you willhave to add an explicit rule in the firewall to allow inbound connection to the specific TCP port and
not rely on the existing rule which allows all connections to the ports governed by NiceLabel Automation Service
process.

Triggers do not run. You might see error message "Could not find a part of the path".

While running NiceLabel Automation keeps a track of trigger activities partly in the temporary folder TriggerData
inside the service user's $temp*% folder. If you remove this folder while the triggers have been loaded and are active, the
NiceLabel Automation activity might be disrupted. In this case, you might see the error messages about "Could not find
a part of the path" in the NiceLabel Automation Manager or returned as feedback from the trigger.

To restore the NiceLabel Automation Service functionality, reload all loaded configurations (recommended) or restart
the NiceLabel Automation Service.

This folder might also be deleted by the computer-cleaning and optimization software, such as CCleaner. Make sure to
exclude the folder $temp%\TriggerData from cleaning,

@ NOTE: The %temp% in this case refers to the temporary folder of the user account that is defined for NiceLabel
Automation Service. That might not be the currently logged-in user.

The changes in default folders done in the NiceLabel Automation Configuration are not applied to the
NiceLabel Automation Service
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NiceLabel Automation Service runs under the Windows account you selected during the installation (or later in the
service properties). If you run NiceLabel Automation Configuration as some other user, you willchange NiceLabel
Automation defaults for that other user.

You must run the NiceLabel Automation Configuration with the credentials of the user account that your NiceLabel
Automation Service runs under.

You can use the command-line utility RUNAS to run Automation Configuration as the user account from the
Automation Service.

runas "c:\Program Files (x86)\EuroPlus\NiceLabel Automation\bin\nconf6.exe"

O When things go wrong

Things can go wrong when using NiceLabel Automation. The fault might be caused by the provided data (for example:
the provided labelis not found, or wrong data was provided for barcodes), or because of the problems in the software.

Places to verify for more details:

1. Automation Manager Log. Automation Manager provides a detailed log of the activities that are happening
in NiceLabel Automation and should be the first thing you check when things are not going as you expected
them to. From the log you can see when triggers were started, stopped or executed, which actions were
executed and when, along with action details like ID (very useful for finding the problematic action in
Automation Builder) and description.

2. Use Save Variable Data and Message Actions. \When you have problems with variable values not being
printed correctly or not being printed at all, you can use Save Variable Data and Message actions to help you
determine what the cause is. Configure Save Variable Data action so that it will save only the variable you have
problems with, or are used in actions that do not work as you expected them to. Message action also allows you
to add an entry to the Automation Manager log with the value of variable. By adding one of these two actions
before the Print Label action, you will see if the correct values are being printed.

3. Event Log. Sometimes an error happens that the authors of NiceLabel Automation did not expect. In such
situations the error is saved in the Windows Event Log. You can view these logs by opening Event Viewer.
NiceLabel Automation logs can be found in the Application section under the Windows Logs.

4. Tracing logs. When you enable tracing in Automation software allinternal commands and activities are
logged to text file. You will enable the tracing mode, if instructed so by the Technical Support Team. For more
information see topic Tracing Mode in Automation help.

Controlling the Service from the Command Prompt
When NiceLabel Automation is installed, two services will start automatically with Windows System:

« NiceLabel Automation Service. Thisis the main engine of the product and does most of the work. It runs triggers,
extracts data using filters and executes actions. This service auto-identifies the Windows bitness and runs in the same
level. The service willrun in x64 mode on Windows x64 and it will run in x86 mode on Windows x86.

« NiceLabel Automation Proxy Service. This service is used primarily for communication between x64 and x86
components that are part of the NiceLabel Automation product. For example, this service will execute VBScript code
that is not supported on x64 platforms.

@ NOTE: Make sure you are running Command Prompt in the elevated mode (with administrative permissions). Right-
click cmd.exe and the select Run as Administrator.

Staring and Stopping the Service

To start services from the command prompt, you can use the following commands:

net start NiceLabelAutomationService

net start NicelabelAutomationProxyService

When starting the Automation Service, you can provide the configuration name in the command line, such as:
net start NiceLabelAutomationService "c:\Project\configuration.MISX"

To stop service from the command prompt, use the following commands:

net stop NicelLabelAutomationService

net stop NiceLabelAutomationProxyService
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Managing Configurations and Triggers

NiceLabel Automation service can be controlled with the NiceLabel Automation Manager command-line parameters. The
general syntax to use command-line parameters is as follows.

NiceLabelAutomationManager.exe COMMAND Configuration [TriggerName] [/SHOWUI]

[@ NOTE: Include the full path to the configuration name, don't use the file name alone. ]

To ADD configuration

The provided configuration will be loaded into service. No trigger will be started. If you include the /SHOWUI parameter,
Automation Manager Ul will be started.

NiceLabelAutomationManager.exe ADD c:\Project\configuration.MISX /SHOWUI
To RELOAD configuration

The provided configuration will be reloaded into service. The running status of all triggers will be preserved. Reloading the
configuration forces the refresh of all files cached for this configuration. For more information, see the topic Caching Files. If you
include the 'SHOWUI parameter, Automation Manager Ul will be started.

NiceLabelAutomationManager.exe RELOAD c:\Project\configuration.MISX/SHOWUI
To REMOVE configuration

The provided configuration and allits triggers will be unloaded from service.
NiceLabelAutomationManager.exe REMOVE c:\Project\configuration.MISX

To START a trigger

The referenced trigger will be started in the already loaded configuration.
NiceLabelAutomationManager.exe START c:\Project\configuration.MISX CSVTrigger
To STOP a trigger

The referenced trigger will be stopped in the already loaded configuration.

NiceLabelAutomationManager.exe STOP c:\Project\configuration.MISX CSVTrigger

Status Codes

Status codes provide the feedback of command-line execution. To enable the status codes return, run the use the following
command-line syntax.

start /wait NiceLabelAutomationManager.exe COMMAND Configuration [TriggerName] [/SHOWUI]
The status codes is captured in the system variable errorlevel. To see the status code, execute the following command.

echo %Serrorlevel$

Status Code | Description

0 No error occurred

100 Configuration file name not found
101 Configuration cannot be loaded
200 Trigger not found

201 Trigger cannot start

Contacting Technical Support

At some point, when you encounter a problem that you cannot solve by yourself, you may need to contact your support
representative for additional assistance.

http://www.nicelabel.com/support/technical-support

[@ NOTE: If you have a Service Maintenance Agreement (SMA), please contact the premium support as specified in the ]
agreement.

Before contacting support it would be very helpful, if you collected information about the problem, the computer and operating
system, you are running NiceLabel software on. You can use the following checklist.
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Checklist

What happened? Write down exactly the error message that you get or make a screenshot of the error.

When was the error discovered for the first time?

What did you expect to happen?

Have you discovered the problem earlier?

Canthe error be reproduced?

How often did the error occur?

Have you tried to use NiceLabel software this way earlier?

If your problem is coming and going, please describe circumstances and under what conditions the error appears.

Which version of NiceLabel software are you using?

Which version of NiceLabel was used to design the label?

Can you provide the files that you were using when the issue occurred (data files, configuration files, labelfiles, etc.)?

Which printer are you using?

Which version of printer driver are you using?

Which operating system are you using? In which language?

Are you using firewall? Are all the required ports open?

O oolooojloooooooo|jo|lo

Which version of Microsoft .NET framework s installed?
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